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Letter from the Project Directors
Dear BioKIDS teachers,

Welcome to the BioKIDS Project! We are very excited to be working with you this fall. We hope that 
both you and your students will enjoy tracking animals in your schoolyard and investigating scientific 
questions related to animal diversity and animal habitats. All activities are matched to the DPS and 
Michigan standards.

Our program starts in early September and runs for eight weeks.  Very soon, we will be sending a Bio-
KIDS project staff member to your school to introduce you to the curricular program and to assist you in 
setting up the technology to be used with this project. In addition, we will be supporting LeTUS teacher 
workshops for ongoing curricular support.  We hope that in addition to these opportunities for feedback, 
you will feel comfortable providing us with your suggestions, comments, and concerns with this new 
inquiry-based biology program.  As always, your comments are very important to us, particularly com-
ments about the ways we can improve the program for you and your students.  The best ways to reach 
us are telephone (Elena at 734-647-2262) and email (ejurasai).

We thank you for your willingness to explore schoolyard biodiversity with us this fall!

Sincerely,

Project Directors,

Dr. Nancy Songer
School of Education

Dr. Philip Myers
Ecology and Evolutionary Biology

Michelle Astolfi
Elisa Collins
Cesar Delgado
Tanya Dewey
Karen Dvornich
Roger Espinosa 
Donnalee Grey
Amelia Gotwals
George Hammond

Anne Huber 
Tricia Jones
Elena Jurasaite-Harbison
Ben Kelcey
Ashima Mathur
Lev Rickards
Melissa Runstrom
Pier Sun Ho
Tom Vlajkov

And the entire BioKIDS Team,
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The BioKIDS Curriculum and the 
Science Education Standards

The National and State Content Standards addressed in the BioKIDS curriculum:

National Science Education
Standards Fundamental Concepts

NSES
Page 

Number

BioKIDS
Learning

Set/Lesson

Science as Inquiry — Content Standard A:  
All students should develop the abilities necessary to do 
scientific inquiry and understandings about scientific 
inquiry (p.143).
Identify questions that can be answered through scientific 
investigations.

Design and conduct a scientific investigation.

Develop descriptions, explanations, predictions, and models 
using evidence.

Use appropriate tools and techniques to gather, analyze, and 
interpret data.

145 LS1/1

LS2/2    LS3/2
LS4/2

LS2/2 
LS4/2

LS2/2 
LS4/2

145

145

145

Life Sciences — Content Standard C:  
As a result of their activities in grades 5-8, all 
students should develop understandings of structure 
and function in living systems, reproduction and 
heredity, regulation and behavior, populations 
and ecosystems, and diversity and adaptations of 
organisms (p. 155).

Regulation and Behavior:
• All organisms must be able to obtain and use resources, grow, 
reproduce, and maintain stable internal conditions while living 
in a constantly changing external environment.
•  An organism’s behavior evolves through adaptation to its 
environment. How a species moves, obtains food, reproduces, 
and responds to danger are based in the species’ evolutionary 
history.

156 LS1/2

157

LS2/2   

LS3/2

LS4/2

Structure and Function:
Living systems at all levels of organization demonstrate the 
complementary nature of structure and function.  
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Populations and Ecosystems:
• A population consists of all individuals of a species that occur
together at a given place and time. All populations living 
together and the physical factors with which they interact 
compose an ecosystem.
•  Populations of organisms can be categorized by the function 
they serve in an ecosystem. Plants and some microorganisms 
are producers—they make their own food. All animals, 
including humans, are consumers, which obtain food by eating 
other organisms. Decomposers, primarily bacteria and fungi, 
are consumers that use waste materials and dead organisms for 
food. Food webs identify the relationships among producers, 
consumers, and decomposers in an ecosystem.
• For ecosystems, the major source of energy is sunlight. Energy 
entering ecosystems as sunlight is transferred by producers 
into chemical energy through photosynthesis. That energy then 
passes from organism to organism in food webs.

LS2/2 
LS3/1
LS3/2

157-158

History and Nature of Science — Content Standard G:
As a result of activities in grades 5-8, all students 
should develop an understanding of science as a 
human endeavor, nature of science, and history of 
science (P.171).

171 LS2/2
LS4/2

Nature of Science:
Scientists formulate and test their explanations of nature using 
observation, experiments, and theoretical and mathematical 
models. Although all scientific ideas are tentative and subject 
to change and improvement in principle, for most major 
ideas in science there is much experimental and observational 
confirmation. Those ideas are not likely to change greatly in the 
future. Scientists do and have changed their ideas about nature 
when they encounter new experimental evidence that does not 
match their existing explanations.
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Michigan Curriculum Framework Science 
Benchmarks (Approved Summer 2000)

Michigan 
Benchmarks

Page 
Number

BioKIDS
Learning

Set/
Lesson

Constructing New Scientific Knowledge (C) I.1

Develop solutions to problems through reasoning, observation, 
and investigations. 
—Key concepts:(K-2) gather information, ask questions, think; 
(3-5) observe, predict, collect data, draw conclusions, conduct 
fair tests; prior knowledge.

2-3
LS2/2
LS3/2
LS4/2

Manipulate simple devices that aid observation and data 
collection.
—Tools:  Various data collection tools suitable for this level, 
such as hand lenses, wind direction indicators, grids for 
sampling areas of the sky or landscape.

2-3
LS1/2
LS2/2
LS2/5

Use simple measurement devices to make measurements in sci-
entific investigations. 
—Key concepts: Measurement units—milliliters, liters, teaspoons, 
tablespoons, ounces, cups, millimeters, centimeters, meters, grams.

2-3
LS1/2
LS2/5

Develop strategies and skills for information gathering and 
problem solving. 
—Tools: Sources of information, such as reference books, trade 
books, magazines, web sites, other people’s knowledge.

2-3
LS2/2
LS3/1
LS3/2

Construct charts and graphs and prepare summaries of observa-
tions. 
—Key concepts: Increase, decrease, no change, bar graph, 
data table.

2-3 LS4/2

Reflecting on Scientific Knowledge (R) II.1

Develop an awareness of the need for evidence in making deci-
sions scientifically. 
—Key concepts: (K-2) observations; (3-5) data, evidence, 
sample, fact, opinion.

5-6

LS3/3
LS2/2
LS3/2
LS4/2

Show how science concepts can be illustrated through creative 
expression such as language arts and fine arts. 
—Key concepts: Poetry, expository work, painting, drawing, 
music, diagrams, graphs, charts.

5-6
LS3/2
LS4/2
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Develop an awareness of and sensitivity to the natural world.  
—Key concepts: Appreciation of the balance of nature and 
the effects organisms have on each other, including the effects 
humans have on the natural world.

5-6
LS1/1
LS3/1
LS3/2

9-10 LS1/2
LS1/3

Explain characteristics and functions of observable body parts 
in a variety of animals. 
—Key concepts: Observable characteristics—fur, scales, feath-
ers, horns, claws, eyes, quills, beaks, teeth, skeleton, muscles, 
exoskeleton; functions—insulation, support, movement, food-
getting, protection.
• Compare and contrast (K-2) or classify (3-5) familiar organ-
isms on the basis of observable physical characteristics. 
—Key concepts: Plant and animal parts—backbone, skin, shell, 
limbs, roots, leaves, stems, flowers, feathers, scales.

9-10
LS1/2
LS1/3

Compare and contrast food, energy, and environmental needs 
of selected organisms. 
—Key concepts: Life requirements—food, air, water, minerals, 
sunlight, space, habitat. See LEC-III.5 e.2.

9-10
LS2/2
LS3/1
LS3/2

Organization of Living Things (LO) III.2

Identify familiar organisms as part of a food chain or food web 
and describe their feeding relationships within the web. 
—Key concepts:  Producer, consumer, predator, prey, decom-
poser, habitat, community.

14-15
LS3/1
LS3/2

Describe the basic requirements for all living things to maintain 
their existence. 
—Key concepts: Needs of life—food, habitat, water, shelter, air, 
light, minerals. See LO-III.2 e.4.

5-6 LS3/2
LS4/2

Evolution (LE)  III.4
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CyberTracker Instructions
(For your reference related to Learning Set 2)

(Abbreviated instructions are also included in the student worksheets.)

CyberTracker is a program that runs on a hand-held device, such as a Palm Tungsten or 
a Pocket PC. Originally developed for trackers in South Africa, you have a version that 
has been customized for schoolyards in Michigan cities. The basic idea is that you step 
through a series of screens to record observations of animals you see in your schoolyard. 

When we use the term “PDA,” we mean a personal digital assistant hand-held device, 
typically made by Palm. “Tap” is the word that means you should press something on 
the PDA screen (you click with a computer mouse, but tap on a PDA). “Screen” means 
all the things you see on your PDA screen at once. You go through a series of screens 
when you use CyberTracker. By “tracking session,” we mean any time you are using the 
program (you might be out in your schoolyard or walking around your neighborhood). 
“Tracker” or “student” refers to the person using the PDA.

Once you understand the basic idea and a few tricks, the software is easy to use.

There are two major sections to using CyberTracker: the “start screens” and the “se-
quence.” Some things will change very little during a tracking session, such as zone, 
tracker team name, and class ID. You fill out these screens at the start of the tracking ses-
sion and probably won’t need to change them. These “start screens” are the first compo-
nent of CyberTracker. After you have entered all this common information, you will cycle 
through a series of screens that help you track the animals you see. This “sequence” is the 
second component.

General Tips

Here are some overall tips to using the CyberTracker program. You will want to show 
these to your students as they are learning the program – either individually or as a class.

Forward and backward buttons appear on the bottom of the screen. You tap the 
forward button after making a selection.  You can use the backward button to review 
or edit previous choices, but please note that the choices you step back through will be 
forgotten. When a list is too long to fit on one screen, a scrollbar appears at the right 
side of the screen. You can tap on these icons or use the up/down button on the PDA to 
scroll.

On some screens, when you tap on an icon in central portion of screen, a name appears at 
the top. When you are not sure what an icon represents, you can tap and hold it to see this 
name.
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Numbers are entered on a screen 
that looks somewhat like a calcula-
tor. “<” is used to delete numbers 
entered.

Using CyberTracker

Turn on your PDA. Tap on the Home icon (bottom left side of the screen) to see all the 
programs on your PDA. If you don’t see CyberTracker right away, switch to “All” using 
the list in the upper right corner. Tap on the CyberTracker icon to start up the program.

The Start Screens (Introductory Section)

The first screen has five options.  You can fill out 
everything here just once and it will stay the same for 
all your sightings until you change one of them.  In 
this screen (and other icon-only screens) you will 
see text at the top of the screen if you tap and hold 
the pen on the icon. To make a choice, tap an icon (or 
later, a menu item) and then tap on the small right-
ward triangle at the very bottom of the screen.   You 
can always back up in the sequence by choosing the 
back triangle.  

On this initial screen, the history bar at the top shows the choices you’ve made in the 
various start screens.

When you first go outside, you should fill in every start screen before you choose the 
BEGIN arrow.  The start screen introductory section options are:
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Class ID. Teachers will tell their classes what number to enter. Each class will 
have a unique ID number, and BioKIDS staff will assign these. The unique IDs 
allow data to be compared across classes and schools.

Tracker name. Teams chose tracker names in Learning Set 1. If you don’t 
recognize your icon while in the CyberTracker program, refer back to Learning 
Set 1 for a reminder.

Zone. Use this to enter the location within your schoolyard where you will fo-
cus your research efforts.  One of the first activities your class will do is make 
a map of your schoolyard. You will divide it into zones and give each a letter. 
At the start of each tracking session, choose the zone you are working in. If you 
move between zones during a tracking session, change this zone code.

Begin arrow.  This arrow takes you to the tracking sequence, the second part 
of the program where you will record animal sightings.

The Sequence

When all the start screens have been filled with data, choose the BEGIN arrow to start 
recording a particular observation. Work through the screens until you have the best 
identification you can make.  You will only be able to record information on one kind of 
animal at a time.

Sighting Method: See, Hear, Smell. Mark how 
you are sensing the animal or its sign. You can se-
lect one, two, or all three of these options, depend-
ing on how you observe the animal. (For example, 
you might smell a skunk but not see it.)

Sighting type: Live animal, track, carcass, scat, 
or sign. Indicate exactly what you are sensing. You 
can select one or more of these options.
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Animal Group: Choose the group that is appropri-
ate for the animal you sense. 

Your choices here are: birds, mammals, amphib-
ians, reptiles, fish, annelids & mollusks, insects, 
arachnids, or myriapods & crustaceans.

The screens change after this point, based on which animal group your organism is in, but 
the general process is the same for all groups. When you choose a group, you will see a 
list of the common species in your area. The list usually starts with “unknown X” (such as 
“unknown bird” or “unknown mammal”). The rest of the list consists of common animals 
in that group, and includes “other X”. You should use “other” if you know for sure the 
animal you are looking at is not on the list (for example, you know for sure it is a Mus-
covy Duck but Muscovy Duck is not on the list) and “unknown” when you are unsure of 
the species.

Choose an animal, then tap on the rightward arrow        to go to the next screen.

Note about invertebrates: Because there are so many 
invertebrates in the world and in your schoolyard, 
some of these groups use more than one screen for 
identification. Whenever you see “…” in a name (such 
as “Slugs and Snails…” or “Butterflies…”, that means 
it links to another screen with more choices.

How many? Enter the number of individuals you 
observed. If you saw only a footprint or sign of an 
animal, such as a web or a nest, enter 1.
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Exact or Estimate: Next you will mark whether it is an 
exact count or an estimated count. (For example, if you are 
looking at an anthill, you probably want to estimate instead 
of count! This is also true if you see a flock of birds fly 
overhead.)

Next you see a set of habitats. This allows you to be 
specific about where you found your animal. 

Remember to tap and hold on a picture if you want 
to see its label.  

To choose, tap the boxes next to the habitats where 
you see the animal. You can choose more than one 
habitat.  For example, a dragonfly may be both in the 
sky and near water.

Choices are:
bare ground, in dirt, short grass, tall grass, leaf litter or mulch, bushes, under something, 
in the sky, single tree, trees together, in water, and near water.

The list is fairly complete. However, if your choice isn’t on the list, choose the habitat the 
animal must have been in before it got where it is.  For example, a bird on a wire might 
be coded as “In the air,” a frog on a lily pad might be coded as “In water.”  You can ex-
plain in a note at the end of the sighting.. If you have to do this often, you might want to 
send a list of suggestions to the BioKIDS team so we can add it to the next version!

If you have had a chance to watch your animal for 
a little while you may want to record what it was 
doing.  Perhaps there are patterns in how the animal 
behaves at a particular time or in a particular place!  
The behaviors screen is where you record this infor-
mation. You will need to scroll to see the complete 
set. 

Tap the boxes next to the behavior the animal dis-
plays. You can choose more than one behavior (for 
example, if the bird is signaling and moving). (You 
can skip this section by tapping the right arrow.)
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Moving – the animal was moving (flying, crawling, walking, running, etc.)  The icon 
is a person running.

Signaling – the animal was making sounds or making a visual display.  The icon is a 
bird singing and displaying its wings.

Resting or sleeping – the animal was quiet or sleeping.  Icon is a person resting.

Feeding – the animal was gathering or chewing food.  Icon is a cow eating.

Drinking – the animal was drinking.  Icon is a cow drinking.

Fighting – the animal was behaving aggressively with another of its own kind.  Icon 
shows two antelopes fighting.

Building – the animal was making a nest or mound.  Icon is a person building a 
house. 

Grooming – the animal was cleaning itself, for example, licking its fur or preening 
its feathers.  Icon is a deer with a comb.

Courting – the animal was attracting or mating with another.  Icon shows two birds 
doing a courtship dance.

The icons are explained below, but remember that when you tap on an icon, you can see 
its name in the top section of the screen. When you are done making your choices, click 
on right arrow.
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If there is anything extra you want to describe 
about your observation, the last screen is the 
place for it.  You can tap on the “ABC” in the 
graffiti writing area to get letters to tap on to spell 
out your note.  For example, if you are recording 
a squirrel nest, you could record “sign” as the 
sighting type, and type “nest” in this note area in 
order to be more specific.  A note can say any-
thing you want.

Tap the   button to save your data about this 
animal.  (Note:  your data will not be saved if 
you do not tap this button.) You will return to 
the first screen, where you tap on                      to 
enter your next animal sighting.

We provide a CyberTracker training exercise where students learn how to record the 
animals in pictures. If you feel the students need more practice, let them record data for 
pictures in your room, or the following list: 3 robins, a lot of ants, a spider under a rock, 
and 1 squirrel that is eating nuts on a tree trunk.
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Downloading Field Data 
(For your reference related to Learning Sets 2, 3, and 4)

After your students have collected their observations in the PDAs, you need to gather the observa-
tions by syncing the individual PDAs to a computer and then uploading the combined data from all 
students to the BioKIDS server. You can then view or print a summary of the data for your students to 
use during other BioKIDS activities.  To do this, you need to do four things:

	 1.  Sync data from all of the individual student PDAs to a desktop computer.
	 2.  Export the data as a text file using the CyberTracker software. 
	 3.  Upload the data to the BioKIDS website (http://www.biokids.umich.edu) using a web 		
                 browser.
	 4.  Print your summary.

1.   Sync the data to your desktop computer
To sync the PDAs:

	 1.   Make sure the CyberTracker desktop software is not running on your computer.
	 2.   One at a time, put the PDA in the cradle and press the Sync button on the cradle.
	 3.   A dialog box will appear indicating that the PDA is connecting to the desktop computer. 	
	       You may be asked to identify which PDA you are syncing (They should correspond to an 	
	       identifying number on the PDA).
	 4.   Eventually another dialog box will appear indicating the number of observations being 	
	       transferred from the PDA to the CyberTracker desktop software.  
	 5.   Repeat the process with all of the student PDAs.

2.  Exporting your class data
To view a data table of your classes’ data (zone summary tables) you need to export a text file con-
taining the observations from the CyberTracker desktop software and upload the text file to the Bio-
KIDS website using a web browser (e.g. Netscape or Internet Explorer).  First, start the CyberTracker 
desktop software on your computer (by double clicking on the CyberTracker (Professional) icon on 
the desktop).  Then:

Open your database:
1.   From the toolbar or the File menu,     
      select Open Database.
2.   In the Open dialog box, select your 
      class database (e.g.
      BioKIDS_2006.MDB).
3.   Click “Open”.
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Export your data:
1.   Go to the View menu and select Reports or choose the Reports from the popup menu just below 
the File menu. 
2.   From the toolbar click on the Export button (see right).
3.   Name the file with a name of your choice (e.g. first_period).  Avoid using spaces in 
the name of the file, instead use the underscore character (as in the example). 
4.   In the Save as type: popup menu, choose “Comma Separated Values.” Your file will be saved in a 
specific format necessary for the (.csv).
5.   Click “Save.” This will save a copy of your data in the My Documents folder.  You can also save 
it to another location (e.g. the desktop) by choosing the location in the top menu (in the figure below, 
this has a folder with the label My Documents).
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3.  Upload data to BioKIDS website
Using an Internet browser (e.g. Netscape or Internet Explorer) go to the BioKIDS website:           
http://www.biokids.umich.edu, click on the link marked “CyberTracker Tools Login” and log in using 
your user name and password.  From there:

1.   Click on the CyberTracker link
2.   Click on the Upload Data link
3.   Find the file on your C: drive that you just exported (it should be in the My Documents folder if 
you have not saved it somewhere else)
4.   Click Upload

After you do this you will receive a message: “Your data was uploaded successfully”. 

4.  Print the Habitat Summary Table or the Zone Summary Table
1.   At this point you will be able to choose between printing the Habitat Summary Table (used in
      Learning Set 2 and 3) or the Zone Summary Table (used in Learning Set 4).
2.   From the File menu of your browser choose Print

You should now have a complete summary table for the data your students have entered into their 
PDAs during their fieldwork data collection.


